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Introduction 
 

 

Welcome to your Learner’s Guide for the Cabinet Maker Program. It will help you to complete the program and to go on to complete further study or 
go straight into employment. 

The Cabinet Maker program is to engage young people with a program of development that will provide them with the knowledge, skills and 
understanding to start this career in Pakistan. The program has been developed to address specific issues, such as the national, regional and local 
cultures, the manpower availability within the country, and meeting and exceeding the needs and expectations of their customers. 

The main elements of your learner’s guide are:  

• Introduction:  
o This includes a brief description of your guide and guidelines for you to use it effectively 

• Modules:  
o The modules form the sections in your learner’s guide  

• Learning Units:  
o Learning Units are the main sections within each module 

• Learning outcomes:  
o Learning outcomes of each learning units are taken from the curriculum document  

• Learning Elements:  
o This is the main content of your learner’s guide with detail of the knowledge and skills (practical activities, projects, assignments, 

practices etc.) you will require to achieve learning outcomes stated in the curriculum 
o This section will include examples, photographs and illustrations relating to each learning outcome 

• Summary of modules:  
o This contains the summary of the modules that make up your learner’s guide 

• Frequently asked questions:  
o These have been added to provide further explanation and clarity on some of the difficult concepts and areas. This further helps you 

in preparing for your assessment.  
• Multiple choice questions for self-test:  

o These are provided as an exercise at the end of your learner’s guide to help you in preparing for your assessment. 
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Module 5: Develop basic computer operating skills 
Objective of the Module: This module covers the skills and knowledge required to Operate MS word, Operate MS Excel, Operate MS Power Point, Perform       

Browsing and Print Document. 

Duration:  100 Hours                          Theory: 20 Hours                           Practice: 80 Hours 

 

Learning Unit   
Learning Outcomes  Learning Elements  Duration  

Materials  

Required  

Learning  

Place  

LU1. Operate MS 
word 

Trainee will be able to: 

 Perform Microsoft basic 

commands in MS word  

 Open File 

 Format a file 

i. Font 

(Type/size/bold/Italic) 

ii. Header Footer 

iii. Page number 

iv. Insert pics / 

table/hyperlink 

 Save a File 

 Save a folder 

 Knowledge of Basic parts of 

computers 

 Importance and use of MS Word 

 Procedure to perform 

various functions in Home 

tab 

 

Theory- 06 Hrs. 

Practical- 33 Hrs. 

Total- 39 Hrs.  

 Computer 

 Windows CD 

 MS office CD 

 

Class Room 
and  

Computer lab 

LU2. Operate MS 
Excel   

Trainee will be able to: 

 Perform basic commands in 

Microsoft MS Excel 

 Open a worksheet. 

 Sum functions 

 If functions 

 Importance and uses of MS Excel 

 Procedure to perform various 

functions in Home tab 

 

Theory- 06 Hrs. 

Practical- 33 Hrs. 

      Total- 39 Hrs. 

 Computer 

 Windows CD 

 MS office CD 

 
Class Room 
and  

Computer lab 
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 Basic calculations 

 Table and graphs 

 Save a worksheet/folder 

LU3. Operate MS 
Power Point 

Trainee will be able to: 

 Prepare Microsoft power 

point presentation with basic 

commands 

 Make a power point file 

 Insert pics/table/hyperlink 

 Design a theme for slides 

 Save a power point file 

 Importance and use of MS Power 

Point 

 Procedure to develop 

presentation 

 

Theory- 06 Hrs. 

Practical- 30 Hrs. 

      Total- 36 Hrs. 

 Computer 

 Windows CD 

 MS office CD 

 
Class Room 
and  

Computer lab 

LU4. Perform 
Browsing 

Trainee will be able to: 

 Perform browsing on the 

internet as per needs  

 Perform search online on 

new trends in the market 

with the help of internet 

 Importance of Internet. 

 Use of various search engines like 

Google, YouTube etc. 
Theory- 04 Hrs. 

Practical- 30 Hrs. 

      Total- 34 Hrs. 

 Computer 

 Internet 

connection 
Class Room 
and Computer 
lab 

LU5. Print Document 

Trainee will be able to: 

 Select Printer  

 Select page setup  

 Print relevant pages 

 Printing Procedure and 

techniques. 

 

Theory- 03 Hrs. 

Practical- 09 Hrs. 

   Total- 12 Hrs. 

 Computer 

 Printing 

 papers 

 (A4 and Legal 

size) 

Class Room 
and  

Computer lab 
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Examples and Illustrations:  

 

Basic Parts of a Computer 

 

A. Input Devices:  

1. Keyboard 

2. Mouse 

3. Microphone 

 

 

B. Process: 

CPU Central Processing Unit 

 

 

C. Output Devices 

1. Monitor 

2. Printer 

3. Speaker 
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MS Word: 
Microsoft Word is a word processing program that was first made public by Microsoft in the early 1980s. It allows users to type and manipulate text in a 
graphic environment that resembles a page of paper. Extra features, such as tables, images and advanced formatting give users more options to customize 
their documents. Over the past three decades, there have been a number of updates and additions to Microsoft Word. Today it is one of the most widely 
used word processors available for Macs and PCs. It is often taught to students in schools and required as part of the basic computer requirements for 
many office jobs. Here you will learn the basic functions of Microsoft Word and how to use them. 

 

Alignment – The alignment options dictate whether the left and right edges of the text in a document adhere to the right side, left, center or justified. 
Alignment can be set from the formatting toolbar at the top of the window or under by choosing “Paragraph” under the Format menu. 

 

Bullets/Numbering – When creating a list of text items, users can choose from several bullet or numbering system to add a small graphic icon or series of 
numbers before each item. To add bullets or numbering to a series of text, click on the corresponding buttons in the formatting toolbar or choose “Bullets 
and Numbering” from the Format menu. 

 

Copy – Copying text simply means making a replica of any text that is currently selecting and saving it to the clipboard. Pressing the Control and C keys in 
Windows or Command and C on a Mac will copy the text. Alternatively, users can also select the text and then click the “Copy” option under the Edit menu 
or in the main toolbar. 

 

Cut – Cutting text removes the text entirely from the viewable document and stores it in the clipboard. Control-X or Command-X are the keyboard shortcuts 
for the Cut function on Windows and Mac respectively. The Cut function can also be found under the Edit menu or the toolbar. 

 

Document – Each document in Microsoft Word is essentially a new file. Each document can be several pages long. A new document can be created by 
hitting Control-N or Command-N, or by choosing the “New Blank Document” option from the File menu or the standard toolbar. 

 

Edit – The edit menu or toolbar in Microsoft Word allows users to perform basic editing functions in their document such as copying, cutting and pasting. It 
also contains options for the Undo and Find/Replace functions. 

 

Font – A font is a type of design for text and typically incorporates this design into each letter, number and symbol found on a keyboard. Fonts can range 
from formal to whimsical. Microsoft Word comes with a series of provided fonts and additional ones can also be downloaded if needed. To change the font 
used in a document, select the text and either click on the main Font menu, the Font drop-down menu in the formatting toolbar or hit Control-D or Command 
D. 

Footer – The footer is the text that consistently appears on every page of a document, at the bottom of each page. Footers normally include details such 
as the page number, or a company’s name and contact details in formal documents. Add or edit a footer by choosing “Header and Footer” under the View 
menu. 
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Format – The Format menu (or toolbar) goes one step further than the Edit menu. Users can make stylistic changes by changing the look of the text itself, 
paragraphs, lists and more. 

 

Header – The header is similar to a footer except that it sits at the very top of every page in a document. Headers often contain page numbers, the document 
name or sub-titles within a document. The header can be edited by clicking on “Header and Footer” within the View menu. 

 

Justify, left justified, right justified – Justification is a type of alignment for text in a word processor. Justify ensures that both the left and right sides of the 
text in every paragraph run in a straight line. Left justify makes only the left side of the text aligned, while the right side remains ragged. Right justified does 
the complete opposite, with only the right side of the text aligned. Users can apply justification to their text by clicking on the corresponding buttons in the 
formatting toolbar or by selecting the text and clicking on “Paragraph” under the Format menu. 

 

Open – The Open command opens an existing document in Microsoft Word. Command or Control plus O, or choosing “Open…” from the File menu will 
provide a pop-up window for users to select the document they wish to open. 

 

Paste – The paste command takes any previously copied or cut text and lays it down within the document where the cursor is pointing. Control or Command 
plus V, or “Paste” from the Edit menu or standard toolbar will run the paste function. 

 

Print – The print command first opens a window where users can specify parameters of the paper, printer and ink they wish to print with and it provides a 
preview of what the physical print will look like. Control or Command plus P, or clicking on “Print” in the File menu or standard toolbar lets users access the 
print window. 

 

Save – The save command is one of the most important ones. It saves all of the work done to date within a document. The save command enables users 
to return to the same document later and continue writing, editing or printing. Control or Command plus S, or clicking “Save” under the File menu or standard 
toolbar will save the document. The “Save As” option is slightly different; it allows users to save the document as a different version by adding a different 
file name. 

Undo – The undo feature keeps track of each command that a user issues while working on their document. Issuing the undo command allows the user to 
go back one step and restore the document as it was before their latest editing command. Related to the Undo command is Redo, which lets the user redo 
the same formatting command again. Control or Command plus Z, or “Undo” under the Edit menu is used to undo a command, while Control or Command 
plus Y or “Redo” under Edit is to redo a command. 
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Keyboard Shortcuts for Microsoft Word 

Shortcuts Keys Operation 

Ctrl+X Cut 

Ctrl+C Copy 

Ctrl+V Paste 

Ctrl+Z Undo 

Ctrl+Y Redo 

Ctrl+S Save 

Ctrl+P Print 

 

Shortcuts for moving around easily / quickly in Word 

Home Beginning of line 

End End of line 

Ctrl + Home Go to start of document 

Ctrl + End Go to end of document 

Right Arrow Right one character 

Left Arrow Left one character 

Ctrl+Right Arrow Right one word 

Ctrl+Left Arrow Left one word 
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Text Formatting Shortcuts in Word 

Ctrl+B Bold 

Ctrl+I Italics 

Ctrl+U Underline 

Ctrl+Shift+L Bulleted list 

Ctrl+L Align left 

Ctrl+R Align right 

Ctrl+E Align centre 
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MS Excel 

 

Microsoft Excel is a program that provides worksheets comprised of rows and columns. Data can be stored in the worksheet, also called a spreadsheet, 
similarly to a Microsoft Word table, but the power of Excel is its ability to perform simple to complex mathematical calculations, and other functions. An 
Excel worksheet, or spreadsheet, is a two-dimensional grid with columns and rows. 

 

What are Excel Formulas? 

Excel formulas help you identify relationships between values in the cells of your spreadsheet, perform mathematical calculations using those values, and 
return the resulting value in the cell of your choice. Formulas you can automatically perform include sum, subtraction, percentage, division, average, and 
even dates/times 

 

1. SUM   

All Excel formulas begin with the equals sign, =, followed by a specific text tag denoting the formula you'd like Excel to perform.  The SUM formula in Excel 
is one of the most basic formulas you can enter into a spreadsheet, allowing you to find the sum (or total) of two or more values. To perform the SUM 
formula, enter the values you'd like to add together using the format, =SUM (value 1, value 2, etc.). The values you enter into the SUM formula can either 
be actual numbers or equal to the number in a specific cell of your spreadsheet. 

You can also practice the Division, Multiplication, subtraction, Percentage etc.  

 

2. IF 

The IF formula in Excel is denoted =IF (logical test, value_if_true, value_if_false). This allows you to enter a text value into the cell "if" something else in 
your spreadsheet is true or false. For example, =IF(D2="Pass","10","0") would award 10 points to cell D2 if that cell contained the word "Gryffindor." 

There are times when we want to know how many times a value appears in our spreadsheets. But there are also those times when we want to find the cells 
that contain those values, and input specific data next to it. 

We'll go back to the example for this one. If we want to award 10 points to everyone who belongs in the Pass Group, instead of manually typing in 10's next 
to each Pass student's name, we'll use the IF-THEN formula to say: If the student is in Pass, then he or she should get ten points. 

The formula: IF(logical test, value_if_true, value_if_false) 

Logical Test: The logical test is the "IF" part of the statement. In this case, the logic is D2="Pass." Make sure your Logical Test value is in quotation marks. 

Value_if_True: If the value is true -- that is, if the student is Pass -- this value is the one that we want to be displayed. In this case, we want it to be the 
number 10, to indicate that the student was awarded the 10 points. Note: Only use quotation marks if you want the result to be text instead of a number. 

Value_if_False: If the value is false -- and the student does not Pass -- we want the cell to show "0," for 0 points. 

 

Microsoft PowerPoint  

Microsoft PowerPoint is undoubtedly the most popular app used to give presentations. You're likely to see PowerPoint presentations used for everything 
from the world's largest companies to grade school teachers sharing lessons. 
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Here are the key actions you'll need to take to build a PowerPoint presentation: 

You'll need to add slides, the individual pages in the presentation. 

You'll add content to the slides, such as text boxes, images, charts and graphs. 

Change themes and styles to make your presentation look professional and fit the occasion at hand. 

Prepare presentation aids like Speaker Notes and Presenter View to help you feel comfortable with presenting 

The Ribbon 

The ribbon menu is found across many of Microsoft's apps, such as Word, Excel, and PowerPoint. It lives above the main area of the application. 

 

 
 

 

 

 

The ribbon contains a series of tabs that you can switch between. Each of these have a unique set of tools to work with your presentation differently. When you switch 
tabs on the ribbon, you'll see new buttons and options to modify your presentation: 

 File. Save, share, and export your presentation. 

 Home. A general purpose collection of the most common tools that you'll use in PowerPoint. 

 Insert. An all-in-one tool to add every imagine-able type of content, such as tables, pictures, charts, video, and more. 

 Design. Controls the overall look and feel of your presentation with theme and style settings. 

 Transitions. Add animations when you switch slides. 

 Animations. Controls the order and style that objects will enter or exit your slide with. 

 Slide Show. Control settings related to the way your presentation appears when sharing it with an audience. 

Now that you understand the layout, you have a better idea of how you can jump to the feature you need. 
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Print a Document 

 

 Open the document or file you want to print. 

 In the top portion of the window of the program or browser you are using, the File menu is in the upper-left corner of the screen. 

 If you clicked File, select Print from the drop-down menu. 

 Either option opens a Print properties window or automatically starts printing the document or file. 

 If the Print properties window is showing, you can specify additional printing options, such as how many copies you want or which specific pages 

you want to print. Once you've selected the options, click Ok or Print to start the printing process. 
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Module 6: Interpret Basic Drawing & Design 

Objective: This competency standard covers the skills and knowledge required to Interpret drawing/ design, Perform Interconversion of Scales, Interpret 

drawing symbols, Take Measurement and interpret Hatching 

Duration: 100 Hours            Theory: 20 Hours          Practice: 80 Hours 

Learning Unit Learning Outcomes  Learning Elements  
Materials  

Required  

LU1. Interpret 
drawing/ design  

Trainee will be able to: 

 Identify drawing/ design/cutting list/material list 

 Interpret the drawing/design 

 Follow the drawing/ design 

 Identify various drawing views 

 Interpret cutting list 

 Size/type of drawing paper 

 Define drawing tools/equipment 

 Elaborate cutting list 

 Elaborate different views of drawing 

 

 

LU2. Perform 
Interconversion of 
Scales 

Trainee will be able to: 

  Interpret scales. 

 Follow interpretation of scale 

 Full 

 Enlarge  

 Reduce 

 Describe Scales and its 

interconversion. 

 

LU3. Interpret 
drawing symbols 

Trainee will be able to: 

 Identify various drawing symbols 

 Follow the drawing symbols 

 Describe drawing symbols  
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LU4. Take 
Measurement 

Trainee will be able to: 

 Identify measuring tools 

 Perform measurement as per drawing  

 Mark the job as per drawing  

 Types of measurement tools  

LU5. interpret 
Hatching 

Trainee will be able to: 

 Interpret section drawing  

 Identify hatching symbols 

 select the required materials for hatching as 

per job requirement 

 Understand the hatching 

symbols/pattern 

 

 

 

Examples and Illustration: 

Drafting 

Drafting is the process of creating a technical drawing to communicate how something is to be constructed. Therefore, it is essential to draft a plan before you begin any 

woodworking project. The failure to do so results in lost time, lost material, lost money, and lost focus. Without a drafted plan your r attention is divided between cutting and 

assembling. In other words, while cutting wood without a plan you are also thinking about how the project will go together, what the next cut needs to look like, and what needs 

to happen next. Since the number one reason for accidents in the woodshop occurs when people do not have their mind on their work, it is reasonable to say that drafting a plan 

not only makes sense to know what to do, but it is also safe. Therefore, plan the work, work the plan. Think it through before you ever begin cutting. Draft a plan! 

 

Plan the work… 

To plan the work, you need to first know what the finished product will look like. This can be accomplished by looking at an already completed project, a 
picture of the project, or a sketch. Having the finished product in mind will help you understand the drafted plans. 

Next, you will need to know how the pieces go together to make the project. This is done by drafting a scaled technical drawing, or a plan. Drawing to scale 
means that the images on the drawing sheet are drawn in proportion to the finished product. That is to say, the drawing is an exact representation of the 
actual product, only smaller or bigger. With this drawing the woodworker can see clearly the exact sizes and shapes to be cut and assembled. 

A scaled drawing can easily be accomplished by using graph paper. For more sophisticated projects the use of an architect’s scale will be necessary. Graph 
paper is a sheet of paper with a series of squares aligned in columns and rows filling the sheet. The most common size square is ¼”. 

When using graph paper, simply predetermine the “value” of each square. This value is called the scale. That is to say, decide what each square will equal 
to draw your project proportionally (¼” = 1”, ¼” = 2”, 
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¼” = ½”, and so on). For example, if your drawing scale is ¼” =1”, for every inch of actual size of your project, you will draw it ¼”, or one square. Let’s say that 

the side of your picture frame is 9”. On your drawing, you would draw a line 9 squares long, or 2 ¼”. You will learn more about scaling a drawing in Unit III: 

Measuring. For now, you just need to know the basics. 

Once you have decided your scale and are certain that your drawing will fit on the sheet of graph paper with the scale that you chose, it’s time to start drawing. 

Your drawing should include all of the necessary information required for building your project. This means you will have to “think it through.” 

 

Think it through… 

Thinking it through means that you consider how each joint will be fastened, the size of lumber you will need, and the size of each cut. You should know all of this BEFORE you 

begin cutting. As you draft your project, build it in your mind. Then, communicate it clearly on your drawing. Your drawing should have the answer to every question a builder may 

ask about the project. 

 

Work the Plan… 

Once you are finished drafting your project, you will know everything there is to know about how to build it: the size of your cuts, the diameter of your holes, the radius of an arch, 

the method of joining wood together, and the size of lumber to pull from the rack. Now, work the plan. Simply follow what you have drawn. Cut all of the pieces first. Then, 

assemble them. 



BASIC 

WOODWORKING 
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 Drafting Tools: 
Before we begin drafting, let’s first look at the tools you will need. 

1. Graph paper: A sheet of paper with a series of squares aligned in columns and rows filling the sheet useful for drawing images to scale. 

 

2. Pencil: Do not draw in ink. Always use a pencil, and begin with a light sketch. You will darken the lines later. 

 

 

3. Straight edge: A straight edge is precisely that…a straight edge. It is a hard, smooth tool used for guiding your pencil to assure that your lines are 

straight. Always use a straight edge. Do not freehand sketch a finished drafted plan. The most common straight edge used for drawing horizontal 

lines is a T-square, which is also used to hold drafting triangles (see below). 

 

 
4. Circle template: A circle template is a smooth, hard flat tool used for drawing circles or arcs. 

 

 

 

5. Drafting compass: A drafting tool used for drawing circles or arcs. 

 

 

 

 

 

 

6. Triangles: Triangles are flat surfaces shaped like triangles used for drawing straight lines 

 



BASIC 

WOODWORKING Draftin
g 
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Multi-View Drawings 

 

In order to effectively plan a woodworking project and think through each step of assembly before you begin, it is necessary to study it from a number of different angles, 

or views. This study is called a multi view technical drawing. Simply put, a view is how something is seen, and in drafting there are many different types of views to help 

you see exactly how something is built. The standard views required in any drafting project are the front, top, and right side views. On more complex projects more views 

are required, but for the most part, these three views will communicate everything you need to know as to how to construct a simple project. 

 

 

Before you Begin: 
As we discussed in the last chapter, begin by choosing the scale of your drawing. Because we want to fit all three views on the same piece of paper, we will use a ¼” 

= 1” scale. After determining the scale, draw a title block around your paper. The title block is a thick line boundary, like margins of an essay, this boundary will 

frame your drawing and provide space to include important information about the project (see sample on the next page). 
 

Where to Begin: 
Since the cd rack is a small project and all three views will fit on the same page, begin drawing the first image, the front view, near the bottom 
left-hand corner of your paper. When drawing multi view images, the views fold out from one another. We place the front view in the bottom 
corner because all other views will fold out from it. That is to say, the top view will be directly above the front view, and the right side view will 
be directly to the right. 

Lightly sketch your drawing on the piece of graph paper first. This will make it easy to make changes before you draw your finished product. 
We will worry about line quality and thickness in the next chapter. 

 

 

 

 

Front View: 
The front view is the image of the object looking straight at it. Every line represents a line as seen in the actual product. Wood has a thickness, so do not draw a single line to represent a piece 
of lumber. 
The sides of this cd rack are 13” tall. On a 1/4” scale, that means the line you will draw to represent one edge of the lumber is 3 ¼” long, or on ¼” graph paper, 13 squares long. Now, you 
must draw the other edge of the lumber. The wood you will use is ¾” thick. Measure over from your first line a little less than one square on your graph paper, or 3/16”, and draw your next 
line parallel to the first. These lines represent each edge of the board. 
Connect the top and the bottom with horizontal lines and, congratulations, you’ve drawn one front view side of your cd rack. Now, repeat the process for each piece of the cd rack and when 
completed, it will look something like the illustration on the right. 

 

Top View: 

The top view is the image of the object looking down on it. This view is drawn directly above the front view. In fact, every corner of the front view drawing should line up exactly 
with the top view. 

 

Right Side View: 

The right side view is drawn directly to the right of the front view. It is what is seen if you stepped to the right and looked at your image. Every corner on the front view should line 
up exactly with the same corners on your right side view. 



BASIC 

WOODWORKING Draftin
g 
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TOP VIEW 

 

FRONT VIEW 

 

Right Side view  





BASIC 

WOODWORKING Draftin
g 
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Module 7: Develop Basic Communication Skills 

Objective: This module covers the skills and knowledge required to Adopt effective listening, Develop nonverbal communication, Develop verbal 

communication, Develop confidence and Pick the right medium.  

Duration: 100 Hours                    Theory: 20 Hours                                  Practice: 80 Hours 

Learning Unit  Learning Outcomes  Learning Elements  Materials Required  

LU1. Adopt Effective 
Listening 

Trainee will be able to: 

 Practice active listening 

 Ask clarifying questions 

 Listen and sympathize with other 

person 

 Describe importance of active 

listening 

 Describe clarity of questioning 

 Explain importance of sympathizing a 

person 

 Multimedia 

 Stationery 

 Effective Listening 

Modules 

LU2. Develop Nonverbal 
Communication 

Trainee will be able to: 

 Adopt hand gestures if required  

 Encourage others to speak 

openly with you 

 Make eye contact with 

communicator 

 Make relaxed, open stance 

during communication  

 Perform friendly tone during 

communication 

 Explain importance of hand gestures 

 Describe importance of encouraging 

others to speak openly 

 Describe the importance of eye 

contact in communication 

 Describe the importance of open 

stance and relaxed communication 

 Explain the usefulness of friendly tone 

 Multimedia 

 Stationery 

 Non Verbal 
Communication 
Modules 

LU3. Develop verbal 
communication 

Trainee will be able to:  Explain face to face conversation  Multimedia 

 Stationery 

https://www.thebalancecareers.com/active-listening-skills-with-examples-2059684
https://www.thebalancecareers.com/verbal-communication-skills-list-2059698
https://www.thebalancecareers.com/verbal-communication-skills-list-2059698


BASIC 

WOODWORKING Draftin
g 
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 Adopt face to face conversations 

 Convey your message clearly and 

directly 

 Adopt phrases as simple as 

possible 

 Respect others and their ideas 

 Explain importance of clarity in direct 

messaging 

 Describe use of simple phrases 

 Describe importance of individual 

respect and their ideas  

 Verbal 
Communication 
Modules 

LU4. Develop Written 
Communication 
Skills 

 Trainee will be able to: 

 Convey your message in few 

words. 

  Convey message through live 

phone calls.   

  Convey message through 

Whatas.  

  Convey message through 

email. 

  Convey message through 

writing. 

 Describe self confidence in interaction 

with others 

 Describe usefulness of firm 

communication in friendly tone 

 Explain the importance of behavioral 

skills 

 Describe the usefulness of sound 

interpersonal skills 

 Define good understanding 

 Multimedia 

 Stationery 

 Written 
Communication skills  
Modules 
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Good Listening Skill: 

Listening is one of the most important skills you can have. How well you listen has a major impact on your job effectiveness, and on the quality 

of your relationships with others. 

For instance: 

 We listen to obtain information. 

 We listen to understand. 

 We listen for enjoyment. 

 We listen to learn. 

 

Becoming an Active Listener 

There are five key active listening techniques you can use to help you become a more effective listener: 

1. Pay Attention 

Give the speaker your undivided attention, and acknowledge the message. Recognize that non-verbal communication also. 

 Look at the speaker directly. 

 Put aside distracting thoughts. 

 Don't mentally prepare a rebuttal! 

 Avoid being distracted by environmental factors. For example, side conversations. 

 "Listen" to the speaker's body language. 

 

2. Show That You're Listening 

Use your own body language and gestures to show that you are engaged. 

 Nod occasionally. 

 Smile and use other facial expressions. 

 Make sure that your posture is open and interested. 

 Encourage the speaker to continue with small verbal comments like yes, and "uh huh." 
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3. Provide Feedback 

Our personal filters, assumptions, judgments, and beliefs can distort what we hear. As a listener, your role is to understand what is being said. 

This may require you to reflect on what is being said and to ask questions. 

Ask questions to clarify certain points. "What do you mean when you say...." "Is this what you mean?" Summarize the speaker's comments 

periodically. 

 

4. Defer Judgment 

Interrupting is a waste of time. It frustrates the speaker and limits full understanding of the message. Allow the speaker to finish each point before 

asking questions. Don't interrupt with counter arguments. 

 

5. Respond Appropriately 

Active listening is designed to encourage respect and understanding. You are gaining information and perspective. You add nothing by attacking 

the speaker or otherwise putting her down. 

 Be candid, open and honest in your response. 

 Assert your opinions respectfully. 

 Treat the other person in a way that you think s/he would want to be treated. 
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What is nonverbal communication? 

Nonverbal communication is the transfer of information through the use of body language including eye contact, facial expressions, gestures and 
more. Verbal communication is the use of language to transfer information through written text, speaking or sign language. 

Nonverbal communication is important because it gives us valuable information about a situation including how a person might be feeling, how 
someone receives information and how to approach a person or group of people. Paying attention to and developing the ability to read nonverbal 
communications is an invaluable skill you can leverage at every stage of your career. 

 

Types of nonverbal communication 

There are several types of nonverbal communications you should be aware of, including: 

Body language: Body language is the way someone situates their body naturally depending on the situation, the environment and how they are 
feeling. For example, someone might cross their arms if they are feeling angry or nervous. 

Gestures: While gestures vary widely across communities, they are generally used both intentionally and unintentionally to convey information to 
others. Someone in the United States might display a “thumbs up” to communicate confirmation or that they feel positively about something, for 
example. 

Facial expressions: One of the most common forms of nonverbal communication is facial expressions. Using the eyebrows, mouth, eyes and 
facial muscles to convey can be very effective when communicating both emotion and information. 

Touch: Some people also use touch as a form of communication. Most commonly, it is used to communicate support or comfort. This form of 
communication should be used sparingly and only when you know how the receiving party feels about touch. It should never be used to convey 
anger, frustration or any other negative emotions in the workplace. 
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Verbal Communication 

Strong verbal communication skills are important for everyone to master. They are extremely valuable in both your personal and professional life. 
When speaking clearly, confidently, and with poise, you are much more likely to command the respect of others and build rapport. This is 
particularly important in business interactions 

Nonverbal elements such as posture, gestures, and facial expressions are also important factors in developing good verbal communication skills. 
Ultimately, good speakers should make frequent eye contact with the audience, let their facial expression show their interest in the ideas they 
are presenting, dress in a way that is appropriate for the occasion and keep their energy levels high. 

Here are the reasons why Oral Communication is great 

 It saves time, 

 It is more effective as emotions are well portrayed, 

 The feedback loop is faster, 

 Verbal communication is economical, 

 The tone is easy to read  

 

Factors of Effective Verbal communication: 

1. Think before you speak  

By organizing your thoughts in advance, you can eliminate many of the awkward pauses that occur when speaking. It will also help you relay 
your information more concisely. 

While writing down your thoughts is not always possible in spontaneous discussions, it is still effective to take a minute to organize your thoughts 
in your mind before you begin to speak. 

 

2. Speak with confidence  

Speaking in a confident manner will help you build trust and command the respect of your audience. There are several factors which can impact 
your ability to speak confidently, including your command of the subject matter, your word choice, the tone of your voice, your body language, 
and your ability to make direct eye contact with your audience. 

3. Be clear and concise  

The most effective way to get your point across is to make it in a clear and concise manner. Avoid using complex, convoluted sentences, and try 
to state your argument in direct language. Before speaking, ask yourself, “What is the clearest way I can make my point?” 
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4. Be aware of your non-verbal communication cues  

Your body language significantly impacts the way others interpret what you say. Pay attention to the gestures you make, your facial expressions, 

and your body language to ensure they align with the message you are trying to get across. 

 

5. Be a good listener 

Being a good listener is as important as being a good speaker, and it will improve the quality of your verbal interactions. It shows the people you 

are speaking with that you genuinely care about their ideas, and it helps ensure you understand their needs. This will enable you to build trust 

and rapport much quicker. 

 

6. Think about the perspective of your audience  

Just because you have a strong command of a topic doesn’t mean the people you are speaking to have the same knowledge as you. 

Try to think about how someone else will understand what you are trying to communicate, particularly if they lack the technical knowledge about 

a subject that you possess. 

 

7. Vary your vocal tone  

Speaking in a monotone voice is a surefire way to bore your audience. Instead, use voice inflection to add emphasis to important points, and 

vary the pitch of your voice to express emotion. This will help keep your audience engaged in your message. 

 

Effective verbal communication is an important skill to understand. Having the courage and ability to convey your thoughts in a respectable way 

will help enhance mutual understanding, trust, decision-making, and problem-solving between yourself and others, making the act of properly 

speaking and listening to an imperative influence on how we learn and think for ourselves. 
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Written Communication Skills: 

Written communication skills can be useful, even crucial, for career success. If you're good at business writing, you're more likely to create a 

good impression. But if you aren't getting the message across clearly with your words, your chances for getting jobs, promotions, raises and 

bonuses may be harmed. 

Whether you’re sending a winning cover letter to a hiring manager, a memo to a colleague, a report to your team or an email to a client, crisp, 

highly focused and error-free writing signals that you’re someone who is organized, knowledgeable and detail oriented. 

Conversely, written communications that are long-winded, imprecise or strewn with typos leave readers wondering how you handle other aspects 

of your job. If your business writing abilities are a weakness, the time to improve is now. 

How to Make Your Writing Communicate? 

Effective writing allows the reader to thoroughly understand everything you are saying. This is not always easy to do. Here are a few tips that will 

help you: 

1. Know your goal and state it clearly. Do you want the reader to do something for you or are you merely passing along information? Do 

you want a response from the reader or do you want him to take action? Your purpose needs to be stated in the communication. Avoid 

information that is not relevant. Clarity is key. 

2. Tone can help your writing be more effective. Certain forms of communication, like memorandums and proposals need a formal tone. 

Writing to someone you know well would need a more informal tone. The kind of tone depends on the audience and purpose of the 

writing. 

3. Explain in clear terms what you want the reader to do. They cannot oblige if they do not understand. Also, they may not even want to try 

to help if the communication is vague and sloppily written. It is good to include why it is beneficial to them to do what you ask or to help 

you. 

4. Language needs to be simple. Do not overuse clichés, jargon, and expressions or try to impress with big words. Keep sentences and 

paragraphs short and concise. 

5. Less is more when it comes to length. Leave out words that do not contribute to the main focus of the communication. This can make 

the reader work harder to know why you wrote. 

6. Using an active voice will strengthen your writing. Sentences that are written in the active voice will flow better and are easier to 

understand. Long, complicated sentences will slow the reader down, even more so if they are written in the passive voice. An active 

example is "I caught the ball." and a passive example is "The ball was caught by me." Active voice will engage the reader and keep his 

attention. 

7. Good grammar and punctuation are very important. It is a good idea to have someone else proofread your writing before you send it. If 

you cannot do that, then try reading it out loud. 
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Module 8: Identify Machines & Its Attachments  

Objective: This module covers the skills and knowledge required to Identify Machine and its sizes, Identify components & Attachments, Identify 

capacities & capabilities of Machine, Identify basic tools and supplies associated with Machines and Maintain Inventory of tools and equipment. 

Duration: 100 Hours     Theory: 20 Hours     Practice: 80 Hours 

Learning Unit  Learning Outcomes  Learning Elements  Duration  
Materials 

Required  

Learning 

Place  

LU1. Identify 
Machine and its 
sizes. 

Trainee will be able to: 

 Identify Wood working machines 

 Check specifications of Band Saw 

machine 

 Check specifications of Circular Saw 

machines 

 Check specifications of Wood Turning 

Lathe 

 Check specifications of Jointer/ Planner 

machines 

  Check specifications of Thicknesses 

machines 

 Check specifications of Sanding 

machines 

 Check specifications of Boring machines 

 Functions and sizes of the 

following machines. 

 Band Saw machine 

 Circular Saw machine 

 Wood Turning Lathe 

 Jointer/Planner machine 

 Thicknesser machine 

 Sanding machines 

 Boring machines 

 

Theory- 03 Hrs. 

Practical- 14 

Hrs. 

      Total- 17 
Hrs.  

 

Class Room 

and 

workshop 
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LU2. Identify 
components & 
Attachments   

Trainee will be able to: 
 Identify different components of relevant 

machine 

  Identify different attachments of relevant 

machine 

 Knowledge about various 

components of wood working 

machines. 

 Knowledge about various 

attachments of wood working 

machines. 

Theory- 04 Hrs. 

Practical-15 Hrs. 

      Total- 19 
Hrs.  

 

Class Room 

and 

workshop 

LU3. Identify 
capacities & 
capabilities of 
Machine 

Trainee will be able to: 

 Check capacity as per manufacturers 

specifications 

 Check capability as per manufacturers 

specifications 

 Interpret proper capacity of machine 

 Interpret proper capability of machine  

 Purpose of 

Attachments used with 

Wood working 

machines, 

  Knowledge about 

machines capacities 

and Capabilities 

Theory- 03 Hrs. 

Practical-15 Hrs. 

      Total- 18 
Hrs.  

 

Class Room 

and 

workshop 

LU4. Identify 
basic tools and 
supplies 
associated with 
Machines 

Trainee will be able to: 

 Check standard tools supplied with 

machines   

 Check spares/consumable materials  

 Follow manufacturers specifications for 

tools and supplies 

 Knowledge of basic Tools, 

Supplies & Lubricants 

associated with Wood 

working machines 

Theory- 05 Hrs. 

Practical-18 Hrs. 

      Total- 23 
Hrs.  

 

Class Room 

and 

workshop 

LU5. Maintain 
Inventory of 
Machines 

Trainee will be able to: 

 Check number of machines as per 

record  

 Report for faulty machine 

 Generate demand for defective parts of 

machines 

 Procedure of Inventory 

management for Wood 

working machines. 
Theory- 05 Hrs. 

Practical-18 Hrs. 

      Total- 23 
Hrs.  

 

Class Room 

and 

workshop 
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 Maintain record of all machines. 

 

 

Examples and Illustrations: 

 

 

The Circular Saw 

 

A circular saw is a power-saw using a toothed or abrasive 
disc or blade to cut different materials using a rotary 
motion spinning around an arbor. A hole saw and ring 
saw also use a rotary motion but are different from a 
circular saw. Circular saws may also be loosely used for 
the blade itself. 

 

 

The Palm Sander 

A good palm sander is vital to any woodworker’s power 
tool collection. The palm sander will use ¼ sheet of 
sanding paper, and is small enough to get into tight 
places. However, you should be careful not to sand 
patterns into your finished work with the palm sander. 
They usually move in a circular pattern, or back and forth. 
Either way, they can leave swirls and streaks in your 
wood that show up once it is stained, so be sure to keep 
it moving across the surface you are sanding so that you 
don’t sand grooves into your wood.  
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The Random Orbital Sander 

 

A random orbital sander is actually a step up from the 
“little brother” version – the palm sander. The random 
orbital sander uses hook and loop (Velcro) to fasten the 
sanding disks to the sanding pad. The random movement 
of the disk helps to avoid sanding patterns into your wood. 
Your main precaution with this tool is to make sure that 
your hardware supply store has discs in stock in every 
grit. Otherwise, you’ll have a sander that you can’t use 
because you can’t find sanding pads for it. 

 

 

A Band Saw Machine can be defined as a cutting 
machine with a long, sharp blade comprising a 
continuous band of toothed metal that stretches between 
two or more wheels to cut material. Band saws feature 
blades of different sizes and tooth pitch. Tooth pitch refers 
to the number of teeth per inch. A band saw can be used 
to cut curves, even in thick lumber, such as in creating 
cabriole legs, to rip lumber and to crosscut short pieces. 
The most common use for the band saw, however, is in 
cutting irregular shapes. The second most common use 
is in resawing or ripping lumber into thinner slabs. A band 
saw also makes the smoothest cuts in woodworks. 
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Wood turning lathes are typically used to shape wood into 
cylindrical profiles. Objects made on a wood lathe include such 
items as furniture legs, lamp posts, baseball bats, bowls and 
other ornamental forms. Wood lathe tooling consists of 
fixturing and securing devices for the work piece, a moveable 
tool rest, and hand-held cutting tools in the form of long 
handled gouges, skews, scrapers, and parting tools. Specialty 
tooling is also available for internal shaping and surface 
development. 

 

A jointer or in some configurations, a jointer-planer (also 
known in the UK and Australia as a planer or surface 
planer, and sometimes also as a buzzer or flat top) is a 
woodworking machine used to produce a flat surface 
along a board's length. As a jointer, the machine operates 
on the narrow edge of boards, preparing them for use as 
butt joint or gluing into panels. A planer-jointer setup has 
the width that enables smoothing ('surface plaining') and 
leveling the faces (widths) of boards small enough to fit 
the tables. 

 

The jointer derives its name from its primary function of 
producing flat edges on boards prior to joining them edge-
to-edge to produce wider boards. 
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A thickness planer (also known in the UK and Australia as a 
thicknesser or in North America as a planer) is a woodworking 
machine to trim boards to a consistent thickness throughout 
their length and flat on both surfaces.  

A thickness planer planes one side of a board at a time, giving 
a board of consistent thickness and with smooth surfaces. The 
cutter head is guided by the opposite surface of the board. 

It is different from a surface planer, or jointer, where the cutter 
head is set into the bed surface. A surface planer has slight 
advantages for producing the first flat surface, and may be able 
to do so in a single pass. However the thicknesser has more 
important advantages in that it can produce a board with a 
consistent thickness, avoids producing a tapered board, and 
by making passes on each side 

 

Wood boring machines are mainly for industrial use 
(woodworking and furniture making), and are used in the 
second phase of wood processing, producing holes or 
slots in the solid timber. Indeed, they are used to make 
groups of multiple holes on the insides of wardrobes and 
cupboards. This type of machine is very useful in cases 
where precise drilling of the panel or of the solid wood is 
needed. This is especially so in the furniture industry that 
requires the creation of holes in the interiors or shelves of 
wardrobes and other items. 
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Frequently Asked Questions 
 

1. What is Competency Based Training 
(CBT) and how is it different from 
currently offered trainings in 
institutes? 

Competency-based training (CBT) is an approach to vocational education and 
training that places emphasis on what a person can do in the workplace as a result 
of completing a program of training. Compared to conventional programs, the 
competency based training is not primarily content based; it rather focuses on the 
competence requirement of the envisaged job role. The whole qualification refers to 
certain industry standard criterion and is modularized in nature rather than being 
course oriented. 

2. What is the passing criterion for CBT 
certificate? 

You shall be required to be declared “Competent” in the summative assessment to 
attain the certificate. 

3. What are the entry requirements for 
this course? 

The entry requirement for this course is 8th Grade or equivalent.  

4. How can I progress in my 
educational career after attaining 
this certificate?  

You shall be eligible to take admission in the National Vocational Certificate Level-3 
in Cabinet Maker. You shall be able to progress further to National Vocational 
Certificate Level-4 in Cabinet Maker Course; and take admission in a level-5, DAE or 
equivalent course (if applicable). In certain case, you may be required to attain an 
equivalence certificate from The Inter Board Committee of Chairmen (IBCC). 

5. If I have the experience and skills 
mentioned in the competency 
standards, do I still need to attend 
the course to attain this certificate? 

You can opt to take part in the Recognition of Prior Learning (RPL) program by 
contacting the relevant training institute and getting assessed by providing the 
required evidences. 

6. What is the entry requirement for 
Recognition of Prior Learning 
program (RPL)? 

There is no general entry requirement. The institute shall assess you, identify your 
competence gaps and offer you courses to cover the gaps; after which you can take 
up the final assessment. 

7. Is there any age restriction for entry 
in this course or Recognition of Prior 
Learning program (RPL)? 

There are no age restrictions to enter this course or take up the Recognition of Prior 
Learning program 

8. What is the duration of this course? The duration of the course work is 1,510 hrs. (11 months) 

9. What are the class timings? The classes are normally offered 25 days a month from 08:00am to 01:30pm. These 
may vary according to the practices of certain institutes. 
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10. What is equivalence of this 
certificate with other qualifications? 

As per the national vocational qualifications framework, the level-4 certificate is 
equivalent to Matriculation. The equivalence certificate can be obtained from The 
Inter Board Committee of Chairmen (IBCC). 

11. What is the importance of this 
certificate in National and 
International job market? 

This certificate is based on the nationally standardized and notified competency 
standards by National Vocational and Technical Training Commission (NAVTTC). 
These standards are also recognized worldwide as all the standards are coded using 
international methodology and are accessible to the employers worldwide through 
NAVTTC website. 

12. Which jobs can I get after attaining 
this certificate? Are there job for this 
certificate in public sector as well? 

You shall be able to take up jobs in the local or overseas construction companies in 
heavy machinery operator job profile. 

13. What are possible career 
progressions in industry after 
attaining this certificate? 

You shall be able to progress up to the level of supervisor after attaining sufficient 
experience, knowledge and skills during the job. Attaining additional relevant 
qualifications may aid your career advancement to even higher levels. 

14. Is this certificate recognized by any 
competent authority in Pakistan? 

This certificate is based on the nationally standardized and notified competency 
standards by National Vocational and Technical Training Commission (NAVTTC). 
The official certificates shall be awarded by the relevant certificate awarding body. 

15. Is on-the-job training mandatory for 
this certificate? If yes, what is the 
duration of on-the-job training? 

On-the-job training is not a requirement for final / summative assessment of this 
certificate. However, taking up on-the-job training after or during the course work may 
add your chances to get a job afterwards. 

16. How much salary can I get on job 
after attaining this certificate? 

The minimum wages announced by the Government of Pakistan in 2019 are PKR 
17,500. This may vary in subsequent years and different regions of the country. 
Progressive employers may pay more than the mentioned amount. The heavy 
Machinery Operator normally earns 20,000 to 25,000 in the start.  

17. Are there any alternative certificates 
which I can take up? 

There are some short courses offered by some training institutes on this subject. 
Some institutes may still be offering conventional certificate courses in the field.  

18. What is the teaching language of this 
course? 

The leaching language of this course is Urdu and English. 

19. Is it possible to switch to other 
certificate programs during the 
course? 

There are some short courses offered by some training institutes on this subject. 
Some institutes may still be offering conventional certificate courses in the field. 
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20. What is the examination / 
assessment system in this program? 

Competency based assessments are organized by training institutes during the 
course which serve the purpose of assessing the progress and preparedness of each 
student. Final / summative assessments are organized by the relevant qualification 
awarding bodies at the end of the certificate program. You shall be required to be 
declared “Competent” in the summative assessment to attain the certificate. 

21. Does this certificate enable me to 
work as freelancer? 

You can start your small business by purchasing your own heavy construction 
machine and can start earning 50,000 per month. You may need additional skills on 
entrepreneurship to support your initiative. 

 

 




